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ANSWERS TO REVIEW QUESTIONS AND CASES 
 
 

For reference, we have included the questions and cases (in italics) with their solutions. These are suggested 
solutions only. Remember that we use general rather than the industry-specific terms in most cases. Answers 
may vary depending on the interpretation of the question or case. Some of the answers we provide may 
include points covered in later chapters. Where discussion is involved, students should be encouraged to 
think of alternative solutions. They should also be encouraged to experiment with entering transactions in 
the data files (after making backups) to discover how the program handles different kinds of transactions. 

 
 
 
CHAPTER 1: GETTING STARTED 

 

Review Questions 
 

1. What are the differences between Save As and Save A Copy (in the File menu)? How are these commands different 
from the Backup command? 

 

The Save As command saves the current working file under a separate file name. That is, it creates a 
separate, working, backup copy of the file and opens the renamed file. If you use the name of an already 
existing file, the previous file will be replaced after you confirm that this is what you want to do. Save a 
Copy will also create a separate working copy of your data file but the current file stays open instead of the 
new file. If you use the name of an already existing file, the previous file will be replaced after you confirm 
that this is what you want to do. As you work in Sage 50, your data file is continually saved with any 
changes you make. The Save tool in the Home window also opens the Save As window. 

 

Backup also makes a copy of your file and keeps the current file open. However, the new file is a compressed 
version of the original data that must first be restored (from the Restore option on the File menu or the 
Company module Data Management icon drop-down list, or from the Select Company window) before you 
can work with it. The compressed file saves data space so it is easier to save separate backups for different 
time periods. 

 

2. Why is it important to make backups of your data files? 
 

If you have a backup, you can return to it if your working data file is corrupted and unusable because of a 
computer error, or if you have made changes to the file that were not correct and cannot be reversed, like 
starting a new fiscal period. (The author has recently had an entire database wiped out while opening a file. 
The resulting file had no ledger records or journal entries. Backups work!) 

 

3. Why can you not open the data files directly from the Student DVD with Sage 50? Why are you able to restore 
backup files from a DVD? 

 

DVD files are read-only files and this property cannot be changed. Because Sage 50 continually saves your 
work by writing to your data file and because it cannot write directly to the DVD, it cannot open the read- 
only files. The read-only property does not allow a file to be changed. The same principles apply to opening 
files from a CD-ROM – these files are also read-only. 

 

You can access and restore backup files from a DVD or CD-ROM because does not write to this same file. 
However, you cannot restore the backup file to either of these medias. 

 

4. How does Sage 50 Help differ from Sage 50 Advice? 
 

Help provides general information about accounting procedures and how to use Sage 50 software. Advice 
includes general information about good accounting practice as well as specific information and advice 
about accounting procedures related to the data file that is currently open. 
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5. Describe the different ways of getting help in Sage 50. 

 

• The Status Bar line shows the purpose of the icon or field on which the cursor is placed. 
 

• The Help function accessed from the Help menu or the Help icon includes an index of topics, a 
glossary of terms and the option to search for help on a topic that you enter. 

 

• Advice on accounting practice and the data file are available from the Help menu and Advice tool 
found in the Business Assistance menu. 

 

• Access to consultants and on-line help is also available from the Help menu when you have an 
Internet connection. 

 

• Enhanced view Module windows include a direct link to the Learning Centre in the Modules list 
pane to access the Help features. 

 

• The Home window in the Classic view includes a Learning Centre icon that accesses the Help 
features. 

 

• Help buttons are also available in other windows and provide context-sensitive help – help about 
the options in the open window. 

 

6. What are the roles of the ledger and journal icons in the Enhanced view module Home windows? In the Classic 
view Home window? 

 

In both the Enhanced view and the Classic view, the ledger icons provide access to the accounting ledgers so 
that you can create and modify ledger records. Before finishing the history for a ledger, you also add data 
from historical transactions and account balances for the records. Journal icons provide access to the journals 
for these ledgers so that you can enter day-to-day accounting transactions that update the ledger records 
automatically. 

 

7. What is the role of the module windows? 
 

The expanded module windows in the Enhanced view show the journals and ledger functions for that 
specific ledger as separate icons and open the specialized journal or ledger features directly. 

 

8. What purpose do the tool buttons in the Home window serve? 
 

Tool buttons in any window provide immediate access to commonly used program functions as an 
alternative to choosing these commands from the main menus. 

 

9. Why might the status bar line in a Sage 50 window be blank? Why is the status bar line important? 
 

The status bar will be blank when the mouse is pointing to a blank portion of the window (not to an icon, 
tool button, menu item or input field) or to an area outside the main Sage 50 screen. 

 

Since the status bar provides descriptive details about the part of the program you are working with, it 
provides an easy way to learn the program and the function of specific items or input fields. It is a form of 
Help for the program.  
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10. How do you open or access a Sage 50 company data file? How do you open the file if you start with a backup file? 
 

The steps in accessing a data file are: 
 

• Double-click the Sage 50 desktop shortcut, if you added one, to open the Select Company window. 
Or, 

 

• Choose Start on the task bar (main Windows desktop). 
 

• Choose All Programs (or Programs) or {Windows10 }-Right click START & select Programs & Features 
 

• Choose Sage 50 Accounting Premium 2016 (or Pro 2017) from the Program Files list. 
• Choose Sage 50 Accounting Premium 2016 (or Pro 2017) from the Sage 50 list to open the Select 

Company window. 
 

• Choose Select An Existing Company from the Sage 50 - Select Company screen. 
 

• Choose the folder that contains your data set from the Open Company window. 
 

• Open the folder. 
 

• Choose the .SAI data file (do not choose the .SAJ folder). 
 

• Double-click the file or click Open to access the file. 

The steps in restoring a backup file are: 

• Double-click the Sage 50 desktop shortcut, if you added one, to open the Select Company 
window. Or, 

 

• Choose Start on the task bar (main Windows desktop). or {Windows10 }-Right click START & select 
Programs & Features 

 

• Choose All Programs (or Programs). 
 

• Choose Sage 50 Premium 2016 (or Pro 2017) from the Program Files list. 
 

• Choose Sage 50 Premium 2016 (or Pro 2017) from the Sage 50 programs list to open the Select 
Company window. 

 

• Choose Restore From Backup from the Sage 50 - Select Company screen. From any open data file, 
choose the File menu and click Restore or choose Restore from the Company module Data 
Management icon drop-down list. 

 

• Click OK to start the Restore From Backup wizard. 
 

• Click Next and then Browse. 
 

• Locate the folder with the backup you want. Click Open to list the files in the folder. 
 

• Click the Backup file you want and click Open or double-click the file to begin restoring. 
 

• Continue with the steps in the wizard to confirm the file you selected and enter the name of the file 
you want to create from the backup. 

 

• Confirm that you are replacing an existing file if necessary. 
 

• Click Finish to display the Session Date prompt. 
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11. What does it mean if the icons for a ledger are missing from the Home window? 
 

If icons for a ledger are missing from the Home window, they may be hidden from the Home window Setup 
menu, User Preferences, View screen or they may have access denied through security/password settings. 

 

In the Enhanced view, only the ledger and journal icons for the open module are shown so the Home 
window will be missing the icons for all the other modules that are not selected. 

 

12. What does it mean if the module names for a ledger are missing from the Home window? 
 

In the Enhanced view, modules that are not hidden are listed in the Modules pane to the left of the ledger 
and journal icons. If modules names are missing, these ledgers have been hidden from the Home window 
Setup menu, User Preferences, View screen or they may have access denied through security/password 
settings. 
13. Describe the differences in the Home window in the Classic and the Enhanced views. 

 

The Classic view Home window shows all the ledger and journal icons for the ledgers that are not hidden. 
Different types of transactions may be selected from within the journals. The tool bar has more options than 
the one in the Enhanced view Home window. 

 

The Enhanced view Home window shows the ledger and journal icons for one module at a time. Separate 
icons provide access to all the ledger tasks and features for that module. Access to the other modules or 
ledgers is available from the Modules pane list or from shortcuts the user has created. 

 

14. What is the significance of the  symbol on a ledger icon? 
 

The not-finished symbol shows that the history for a module has not been closed off or finished. Historical 
opening balance data may still be added or changed at this stage. 

 

15. In the Classic view, if you have selected the General Journal icon, and you point to the Suppliers icon, what will the 
status bar line tell you? 

 

The status bar will describe the function of the Suppliers icon because that is the location of the mouse 
pointer. Suppliers contains information about the suppliers/vendors from whom you make purchases. 

 

16. What happens if your date format is set up as day-month-year? How can you change it? 
 

If your date format is set as day/month/year, any date that can be ambiguous (i.e., the first two numbers 
entered are both 12 and less) may be misinterpreted by the program (day and month will be reversed). For 
example, May 10 (entered as 5-10) might be recorded as October 5. Date formats are changed from the Setup 
menu, Settings option, Company, Date Format screen. Date formats can be set and apply only to the data file 
that is open. If the date you enter is ambiguous, you must use the date order that is selected in the data file to 
enter the correct date. The year can also be entered as two digits and may have also create ambiguity for the 
early 2000 years. 

 

17. How does the computer system date format (day, month, year or month, day, year) affect the Sage 50 data file? 
 

It does not affect the data formats in Sage 50 because these can be set from within the program for each data 
file. (Note: The computer system date format is used as the initial default when you create a new company 
from scratch.) 

 

18. If you are unsure of the date format settings, how can you enter a date to determine the date format settings? 
 

You can enter a data that is not ambiguous, such as 20-05-2019 to see how Sage 50 displays it in the Date 
field. If the order is mm-dd-yyyy, the date will display as 05-20-2019, whereas if the order is 
dd-mm-yyyy, the date will display as 20-05-2019. You can also enter a date as text, such as May 12, 2019, or 
choose a date from the Date field pop-up calendar to see how the program displays it. 
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19. If you are unsure of the date format settings, how can you enter a date to be certain that it is interpreted correctly? 
 

Enter the date in text format or choose a date from the pop-up calendar in the Date field. 
 

20. How do you finish a session in Sage 50? 
 

Before closing the program and data file, back up your data file. Then choose the Control Menu icon and 
click Close, or click the Close button, or choose the File menu and click Exit. 

 

21. What must you do before you can work with your company data files in Sage 50? 
 

You will need to install the Sage 50 program and register or activate it – immediately before you can use the 
Student version or before the trial period expires for the non-student retail versions. Payroll must also be 
activated before it can be used in the non-student retail programs. Automatic payroll updates should be 
turned off to work through the applications in the Text. You must also have your company data on a re- 
writable medium such as a hard drive or a USB memory drive. 
 

22. What features in the Enhanced view Home window require an Internet connection?  
 

Accessing the SAGE 50 Learning Centre 
 

23. What information does the Dashboard window provide? How do you close this window? 
 

The Dashboard window provides the title bar containing the program name and file name. This is followed 
by a menu bar and a tool bar which provides quick access to menu items and the search function. It also 
provides several key performance indicators in various panes in both graphic views and tables. Clicking on 
any other module in the Modules pane will close the Dashboard window. 

 

24.  How does the Dashboard window differ from other Sage 50 windows? 
 

The Dashboard window does not provide ledger and journal icons, but provides a Revenue Summary, Bank 
account balances, Aged Receivables, Aged Payables, Order Summary, and Revenue vs Payroll expenses in 
various panes in both graphic views and tables. 
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CHAPTER 3:    BINH’S BINS 
 

Review Questions 
 

1. How is the posting date different from the session date? 
 

The posting date is the actual date that the transaction occurred and this date should be recorded for the 
transaction in the journal. The session date is the date that the transactions are entered into the computer 
program, usually the calendar date in an ongoing business. The posting date may be earlier than the session 
date, but cannot be earlier than the Earliest Transaction date – the date you started to record ongoing journal 
transactions in Sage 50. Dates later than the session date may be entered if future dates are allowed in the 
Company Settings. 

 

2. List some of the different ways to enter June 09, 2021, in a date field. 
 

The following formats assume that the data file date format is month-day-year – as in all our data files. For 
other date formats, the order for month, day and year will change accordingly. 

 

• June 9 
 

• june 9 
 

• june 9 21 
 

• 60 
 

• 06  21 
 

• 6/0 
 

• 06/21 
 

• 6 21 or 6 20 2021 
 

• 06 9 21 or 06 09 2021 
 

• 6/9/21 or 6/09/2021 
 

• 06/9/21 or 06/09/21 
 

You can use different separator characters to replace the / above. In some date fields you may need to 
include the year. For example, if the fiscal period is longer than one year, the date might be incorrectly 
interpreted as May 9, 2020 or May 9, 2021. In this case, you can still enter the year as two digits. 

 

3. How does Sage 50 help provide a complete audit trail? 
 

Sage 50 Accounting does not allow entries to be deleted. It requires that you correct journal entries after 
posting by making complete reversing entries; it provides a complete record of all transactions for an audit 
trail. You must provide all details (source, date, debit and credit accounts and amounts) before you can post 
an entry. The Journal report includes all the transactions entered, including these reversing entries when 
you show the corrections, with full details of the transaction date, the source of the entry and a descriptive 
comment. Thus it is possible to trace the work completed. 

 

For the journals that include the Adjust An Entry option, the program automatically creates this reversing 
entry, posts it and adds it to the journal report. These same journals also have the option to reverse 
transactions in a single step. Again, Sage 50 does not remove the entries; it adds a reversing entry instead. 
Displaying these corrections is an option in journal reports so that the complete record is always available. 
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4. What are some of the advantages of entering transactions in Sage 50 over using a manual accounting approach? 
Are there any disadvantages? 

 

The main advantages are the built-in controls and the ease of generating reports. Because the software will 
not allow posting of entries until all information is added to the journal and debits and credits are equal, the 
chance of making a mistake is reduced compared with the manual entries where omissions might not be 
noticed. Reports are available instantly for any time period without extra data entry. Ledgers are updated 
automatically and do not require separate entries. 

 

The Adjust An Entry feature in Sage 50 can also save time and prevent errors by allowing a previously 
recorded entry to be recalled, corrected and resaved. The program automatically creates the intermediate 
reversing entry and minimizes the chance of making an additional error. Similarly, the program can create a 
reversing entry automatically when no further corrections are needed. Again, the opportunity for error is 
reduced. 

 

The principal disadvantage is probably the need to enter complete setup data for the company. However, the 
initial data required is minimal (most data can be added later when it is needed) and the time saved for 
preparing Trial Balances, Balance Sheets and Income Statements is more than made up by the setup time. 
Some people feel that the inability to “erase” mistakes is a disadvantage. It is, however, an important control 
technique that allows the software to be used in real business settings, so this feature has its own advantages. 
Instead of erasing incorrect entries, Sage 50 can reverse them automatically in most journals. 

 

5. Describe a method of creating new General Ledger accounts. 
 

You can create new accounts from any Account field in a journal by double-clicking while in the field to 
access the Select Account screen. Click Add New Account and click Create to start the Account Wizard. You 
can also type in a new unique account number. When you press Tab or Enter, Sage 50 recognizes that the 
number is new and asks if you want to create or add it. If you choose Yes, the Add Account Wizard will 
begin. 

 

6. What are the limits on entering new session dates? On entering transaction dates? 
 

You can advance the session date up to the first date of the next fiscal period. After starting a new fiscal 
period, you can enter later session dates for the new fiscal period up to the end of the new fiscal period. 
Transaction dates must fall between the Earliest Transaction date and the session date. You cannot go 
beyond a current session date until you advance the session date (unless you have allowed future-dated 
transactions). You can also move the session date to an earlier date, up to the Earliest Transaction date – the 
date you started to record ongoing journal transactions in Sage 50. Entering a date for the Company - System 
screen option Do Not Allow Transactions Dated Before can also place restrictions on the dates you can enter 
and prevent the user from entering incorrect earlier dates. 

 

7. What date appears as the default in journals? In reports? 
 

The default date in journals and reports is usually the session date. If you have a journal open after posting a 
transaction, the default date is the posting date used for the previous entry. Income Statements, and other 
reports that cover a period of time, have the Fiscal Start and the session date as the default start and finish 
dates respectively. The session date is the default for reports that are prepared for a single date. 
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8. How is a General Journal entry in Sage 50 different from a manual accounting journal entry? 
 

In Sage 50, source information is required before you can post the entry and debit and credit entries must be 
equal. The account balances are automatically posted to the ledger records for the accounts used, so the 
General Ledger is continually updated. The manual system has no built-in controls for the accuracy of the 
bookkeeper. It is possible to record an incomplete entry and the ledger records must be updated separately, 
creating another opportunity to transcribe the amounts incorrectly. Neither system has the ability to detect 
an incorrectly chosen account, although the software includes the complete account names so you can more 
easily check your work. 

 

9. Describe the different ways that you can add the account number to the account field in the General Journal. 
 

You can type the account number directly into the Account field in the journal. You can also find the number 
in the Select Account list. To access the account selection list, click the list icon in the Account field, press 
Enter when the cursor is in the Account field or double-click the Account field. If you type a number in the 
account field before opening the selection list, the list will advance to the first account beginning with that 
number. In the selection list, click the account you need and press Enter or click the Select button to add the 
account to the account field in the journal. 

 

10. Describe the procedure for correcting a journal entry after posting. 
 

Click the Adjust An Entry tool button or choose Adjust An Entry from the Entry menu in the journal. Browse 
to locate the journal entry you want to correct and double-click it to open it, or click to select it and then click 
the Select button. Make the corrections and post the changed transaction. Sage 50 posts two entries — the 
reversing entry and the correct transaction entry. If an entry should be removed, it can be reversed (see 
question 19). 

 

11. Describe the procedure for correcting a journal entry before posting. 
 

Return to the field that has the error. Clicking the field is the easiest way to return to it. Select the text you 
want to change by clicking or dragging through it and type the correct information. To change an account, 
click the Account field and press Enter to open the Select Account list. Double-click the account you need or 
click it to select and click the Select button to add the account to the journal. 

 

12. What does it mean if a button or menu option is dimmed? 
 

The option you are selecting is not available. The option may be turned off, not available because of multi- 
user restrictions, or the command may not apply for the present situation – such as trying to use the copy 
command when no text has been selected. 

 

13. How do you advance the session date in Sage 50? 
 

Close all open windows. You cannot change the session date while other Sage 50 windows are open. You can 
use the Home window Close All Windows tool or close each window separately. Then choose Change 
Session Date from the Maintenance menu, enter a new date and click OK. You can also click the date 
calendar icon beside the current session date on the right-hand side of the Home window in the Enhanced 
view to open the calendar. Click the new session date on the calendar and then click OK to enter the date and 
return to your Home window and entering transactions. 
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14. Why would you choose to advance the session date by one week at a time instead of one month at a time if you are 
entering transactions for one complete month? 

 

Advancing the session date in smaller increments helps to avoid entering an incorrect transaction date for an 
entry. 
 

15. When would you restore a data file from the backup copy? How would you do this? 
 

You would restore a backup if the original file had been corrupted or damaged so that you could not open it, 
or if the original file has recent accounting errors that cannot be reversed or corrected. If you have entered 
other transactions or data after this backup was made, you will need to re-enter that data. 

 

To restore the backup, choose Restore from the File menu in the Home window or from the Company 
module Data Management icon drop-down list, or choose Restore From Backup in the Select Company 
window when you start Sage 50. Follow the instructions in the Backup wizard screens to select the backup 
file and to name the restored file. If the name is the same as the one you used before, you must confirm that 
you want to replace the existing file. 

 

16. What does customizing a report mean? Why might you customize a report? How would you do this? 
 

Whenever you change the default settings you are customizing a report. You can change the default columns 
that are displayed and you can sort or filter the information according to selected criteria. 

 

You might want to customize a report because you want to show information in a different way that is more 
appropriate to your business. You might also choose to omit information that does not apply to the business 
or perhaps to the particular group you are preparing the report for. 

 

To begin the customizing, display the report and click the Modify Report tool to open the Report & Forms 
Options window. From the Report Centre, select the report you want, click Modify This Report and click OK 
to open the Report Options window. Then click Report Options, Report Columns, Filter Report or Sort 
Report to begin entering the changes you want. 

 

17. What is the difference between sorting and filtering a report? 
 

Sorting changes the order of information in a report based on the criteria you choose, such as showing latest 
to earliest date order instead of earliest to latest or sorting by amount or source document. All the data will 
be included. Filtering selects or includes only part of the data based on the criteria you choose, such as 
showing only journal entries with source codes that include a key word. 

 

18. Describe how to Select A Report in the Home window tool bar. 
 

The Display tool in the Classic view accesses lists and journal reports (or the related report options window) 
directly when a ledger or journal icon is selected. When no icon is selected, the tool will access a drop-down 
list of these same reports. The tool button bypasses the Reports menu. 

 

19. How do you reverse a General Journal entry? Why would you do this? 
 

To reverse an entry, click the Adjust A Previously Posted Entry tool or choose the Entry menu and click 
Adjusting Entry to open the Search window. Enter the search parameters to help you locate the entry you 
need. Click OK to list the transactions that meet the search criteria. Click the transaction you want and click 
Select to display the transaction in the journal window. At this stage, you can make corrections or reverse the 
transaction. To reverse it, click the Reverse Entry tool or choose the Entry menu and click Reverse Entry.  
Click Yes to confirm. 

 

You might choose to reverse an entry if you had entered it twice by mistake. You might also reverse an entry 
that had a large number of errors. Reversing it first and re-entering it from scratch might be simpler than 
making a large number of changes. 
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20. What is the difference between backing up a file for the first time and making additional backups? 
 

The first time you make a backup, the default name is a new backup1.CAB file in a new Backup folder inside 
your working data file folder. The comment for the backup includes the number 1. You will be asked if you 
want to create the new file and folder. 
The next time you back up the same file, the default location and name will the ones you used before 
(BACKUP folder and backup1.CAB if you used the defaults). The comment number will be updated to 2. If 
you are using the same file name as before, you will be asked if you want to replace the existing backup file. 
The number in the comment will be updated with each backup even when you change the file name. 

 

21. What is a session date? How does it affect journal entries? Why is it important? 
 

The session date is the date you are entering transactions, usually the current calendar date in an ongoing 
business. When you open a journal window, this will be the default date for posting a transaction unless you 
enter a different date. If future-dated transactions are not allowed, the session date is the latest date you can 
use for a journal transaction. In this way it offers an important control that minimizes the chances of entering 
an incorrect date. Since the posting dates are used to generate reports, entering accurate journal dates will 
help to create accurate reports. For sales and purchases, dates also affect the availability of discounts and 
interest charges on overdue accounts. 

 

22. If you enter a date as 02-03-12, what date will Sage 50 enter in the journal date field? 
 

The date you see in Sage 50 depends on the short and long date formats you have selected. 
 

If you display short dates in journal entries (and reports), you will see 02-03-12 in the date field, but the date 
represented will change according to your format selection – month, day or year may come first. Thus the 
date may February 3, 2012, if your order is mm-dd-yy, March 2, 2012, if your order is dd-mm-yy, or even 
December 3, 2002 if your order is yy-dd-mm. 

 

If you display long dates in journal entries (and reports) the display will vary as follows: 
 

• If your date format is MMM-dd-yyyy, you will see Feb 03, 2012. 
 

• If your date format is MMM-dd-yy, you will see Feb 03-12. 
 

• If your date format is dd-MMM-yy, you will see March 02-12. 
 

• If your date format is dd-MMM-yyyy, you will see March 02, 12 
 

23. How does accessing reports from the Report Centre differ from using the Reports menu? 
 

The Reports menu always opens the Report Options window before displaying a report. The Report Centre 
shows a sample of the report and a description as soon as you select the type of report. Then you can click 
Display to open the report immediately with the default settings or click Modify This Report to open the 
Report Options window. 
 

24. The Select A Report, Reports menu, Reports pane list, Reports icon and Recent Reports pane all off ways to view 
reports. How are they different, and in what ways are they the same? Can you obtain the same reports from all of these 
approaches? If so, how? 

The Select A Report tool is in the Classic view, and the Reports list and the Reports Centre in the Home 
window of the Enhanced view. The menus provides access to all reports and by selecting one of the reports on 
the list, the list is expanded to provide all of the reports available for the chosen journal or analysis. The report 
for the journal has to be selected and opened.  The process of selection is required to access the desired report. 
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25. What are drill-down reports? How do you access them? What information do they provide? 
 

Drill-down reports are additional reports that you see from an open report window. They usually provide 
(drill down to) more detail about some part of the report. For example, you may access the ledger record for 
an account, the detail for a summary listing, a journal report entry or the original journal entry. 

 

When you move the mouse pointer over any part of the report display, a magnifying glass icon appears if 
there is a drill-down report available. The status bar names the drilled down report you can see. Double- 
clicking this detail in the report will open the secondary or drilled-down report. 

 

26. When will the report from the Recent Reports pane display a modified report and when will it display the report with 
the Sage 50 original default options? 

The Default Report option appears as the template the first time you view a report. The next time you open the 
previously selected report window the Last Used Report option will display as the template. 
 

27. What information and options do you have in a backup window, the first time you back up your file and for later 
backups? 
 

When backing up the file the options available are “Do you want to backup this company before closing?” Yes 
or No. The option “Do Not Ask Again” and there is also a Help option. 
 

28. What happens when you use the same file name for all backups for one company? 
 

You will not have backups for different stages of the transaction recording to return to if you find errors. 
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1360 Supplies 60.00 (new Account required) 
2670 GST Paid on Purchases 3.00  

1080 Cash in Bank  63.00 
 

Review Cases 
 

Case One  
 

At the end of April 2021, after paying several bills Binh completed the following manual journal entries to record 
the transactions:  

 

Date Ref. Accounts Debit Credit 
Apr. 30 rent (cheque #53) Rental Expense 800.00  
  GST 40.00  
  Bank  840.00 
Apr. 30 hydro(cheque #54) Expenses 130.00  
  GST 6.50  
  Bank  136.50 
Apr. 30 telephone (cheque #55) Phone Expenses 121.00 

 
 

  GST 6.05  
  Bank  127.05 
Apr. 30 printer cable (cheque #56) Supplies  20.00  
  GST 1.00  
  Bank  21.00 
Apr.30 Invoice forms (cheque #57) Supplies 40.00  
  GST 2.00  
  Bank  42.00 
Using the account in the Binh’s Bins data file, manually prepare the detailed journal entries that record these 
transactions as they would appear in a Sage 50 journal report. (You may want to print a General Journal Report 
for reference to find what details Sage 50 provides.) 

 

How is the Sage 50 method of entering journal transactions different from the manual accounting procedures? 
What are the advantages of using Sage 50? 

 

Account numbers and proper account names must be added. The last two purchases should be combined 
because they use a single cheque number and the same asset account. The Sage 50 entries are: 

 

Apr.30-21 CHQ 434, pay office rent   
 5120 Rental Expenses 800.00 
 2670 GST Paid on Purchases 40.00 
 1080 Cash in Bank  840.00 
Apr.30-21 CHQ 435, pay hydro account   
 5060 Insurance Expense 130.00  
 2670 GST Paid on Purchases 6.50  
 1080 Cash in Bank  136.50 
Apr.30-21 CHQ 436, pay telephone account   
 5140 Phone/Internet Expenses 121.00  

2670 GST Paid on Purchases 6.05 
1080 Cash in Bank 127.05 

Apr.30-21   CHQ #437, printer cable & Bin Locks 
 
 
 
 

 
Sage 50 requires that all accounts (and headings, totals and subtotals) have numbers. You may use from 4 to   
8 numbers in the Premium version. The sequence of these numbers must follow the pattern of 1000s = Assets, 
2000s = Liabilities, etc., for 4-digit account numbers so that the program will know how to prepare the 
financial reports (e.g., whether a debit entry will increase or decrease the account balance). New accounts 
must be inserted in the correct sequence, and the numbering requirement means that sometimes they cannot 
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just be squeezed between two other accounts. An entry with unequal debits and credits cannot be posted, so 
the program provides a check on the accuracy of the arithmetic and typing entries. It automatically calculates 
and enters as a default the debit or credit amount that will balance the entry as you complete a transaction so 
you do not need to type the final amount. This can save some data entry time and allow you to verify your 
own amounts. You do not need to write the account name in full. Entering the number (or choosing it from 
the list) is sufficient. The program fills in the account name so it is easy to check your entry. This saves time 
when you enter the transaction, but still provides complete information in the journal report. The journal 
report provides an audit trail very simply when you show corrections, and the software can also generate 
other major financial reports. 

 

Case Two 
 

Complete the following purchase in the General Journal. 

Purchase Invoice #DE-67113 Dated May 7, 2021 

From Devon Equipment Co., $600 plus $15 GST for a demolition chute that places debris directly into a bin. Invoice 
total $630. Terms: net 30 days. 

 

After posting the above transaction, you realize that the equipment was rented instead of purchased, so it should be 
charged to the equipment rental expense account. 

 

Make the corrections necessary to reflect this expense accurately. 
 

Why is it important to make the correction? What if another expense account were used as the original incorrect 
account so that the income would not change on the income statement? Would it still be necessary to make the 
correction? Why? 

 

The original entry can be adjusted using the Adjust General Journal Entry feature. Find the original entry 
and edit the account number. The following three journal entries will appear in the journal report: 

 

Original entry: 
 

07-31-21 J33 DE-67113, Demolition chute   
 1560 Dumpsters  600.00 
 2670 GST Paid on Purchases 30.00  
 2210 A/P - Devon Equipment  630.00 

Reversing entry: 
 

07-31-21 J34 ADJDE-67113, Reversing J33. Correction is J35. 
2210 A/P - Devon Equipment 630.00 

1560 Dumpsters 600.00 
2670 GST Paid on Purchases 30.00 

Correct entry: 
 

07-31-21  J35 (Correct) DE-67113, Dumpsters 
  5120 Rental Expense 600.00 

2670 GST Paid on Purchases 30.00 
2210 A/P - Devon Equipment 615.00 

The correction is important because assets do not appear on the income statement and costs would be 
understated. If another expense account had been used in error, the change should still be made. It is 
important to record expenses correctly because the historical expense information is used to make decisions 
about future purchases. For example, if a business rents the same equipment frequently, it may decide to 
purchase the equipment instead of renting. Accurate information about expenses is also needed for future 
cost reduction decisions. The journal report with corrections will show all the entries, providing a complete 
audit trail. 
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